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About us

株式会社エヌ・エフ・ラボラトリーズ
リバースエンジニアリング、

マルウェア解析講師

株式会社エヌ・エフ・ラボラトリーズ
オフェンシブ科目講師

株式会社エヌ・エフ・ラボラトリーズ
マルウェア解析講師
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Key takeaway

• .NETのNative AOTでコンパイルされたプログラムの内部構造
に関する基礎知識

• 静的解析を効率化するためのシグネチャの作成方法

• シグネチャやプラグインを活用し、膨大なコードから読むべき
コードを絞り込む(トリアージ)手法
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本日の流れ

• 前半
• .NETのマルウェア解析の基礎(Managed vs Native AOT)

• GhidraやIDA Proを用いたシグネチャの作成とライブラリ関数の識別

• (休憩 10分)

• 後半
• プラグインを使用してオブジェクトメタデータの復元
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ちょっとだけ質問です

• マルウェア解析の経験がある方（趣味・実務問わず）

• CTF等でリバースエンジニアリング(Rev)問題をやったことのあ
る人

• .NETの解析に触れたことのある方

• 解析自体が今回初めてという方
• 経験のある方は、周囲にいる初学者の方をサポートしていただけると

幸いです！
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Re:birth the fidb: 

Reverse Engineering the .NET AOT Malware

section #1
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最近の事例

Native AOTでコンパイルされたマルウェアの事例が

少しずつ確認されるようになっている
Booking.com Phishing Campaign Targeting Hotels and Customers - Sekoia.io BlogIBM X-Force Threat Analysis: QuirkyLoader - A new malware loader 

delivering infostealers and RATs | IBM

Impersonated GenAI Site Lures Victims to Infostealer Download - Check Point Research

https://blog.sekoia.io/phishing-campaigns-i-paid-twice-targeting-booking-com-hotels-and-customers/
https://blog.sekoia.io/phishing-campaigns-i-paid-twice-targeting-booking-com-hotels-and-customers/
https://blog.sekoia.io/phishing-campaigns-i-paid-twice-targeting-booking-com-hotels-and-customers/
https://www.ibm.com/think/x-force/ibm-x-force-threat-analysis-quirkyloader
https://www.ibm.com/think/x-force/ibm-x-force-threat-analysis-quirkyloader
https://www.ibm.com/think/x-force/ibm-x-force-threat-analysis-quirkyloader
https://www.ibm.com/think/x-force/ibm-x-force-threat-analysis-quirkyloader
https://www.ibm.com/think/x-force/ibm-x-force-threat-analysis-quirkyloader
https://www.ibm.com/think/x-force/ibm-x-force-threat-analysis-quirkyloader
https://www.ibm.com/think/x-force/ibm-x-force-threat-analysis-quirkyloader
https://research.checkpoint.com/2025/impersonated-kling-ai-site-installs-malware/
https://research.checkpoint.com/2025/impersonated-kling-ai-site-installs-malware/
https://research.checkpoint.com/2025/impersonated-kling-ai-site-installs-malware/
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最近の事例

Native AOTでコンパイルされたバイナリはステルス性が高く、解析
が難しい

Impersonated GenAI Site Lures Victims to Infostealer Download - Check Point Research

https://research.checkpoint.com/2025/impersonated-kling-ai-site-installs-malware/
https://research.checkpoint.com/2025/impersonated-kling-ai-site-installs-malware/
https://research.checkpoint.com/2025/impersonated-kling-ai-site-installs-malware/
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そもそも.NETのマルウェアはどうやって解析するの？
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• .NET(C#言語など)で作成されたマルウェアは、コンパイルの方
法によって解析のしやすさが変わる

• デフォルトでは、IL(中間言語)が含まれるため、
dnSpy/dnSpyExやILSpyなどを使ってデコンパイルすることで、
高級言語のレベルで解析することができる
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dnSpyでデコンパイル
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• Ready To Run
• アセンブリにILとネイティブコードが含まれる

• AOT(Ahead-Of-Time)形式

• .NETの最適化により、プラットフォームによってはILではなく、
ネイティブコードが実行される

• 解析では、実際にどちらが実行されるのかに注意を払う必要が
ある

• ILSpyを使うと、ILのデコンパイルとネイティブコードのアセ
ンブリを比較してみることが可能
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• Ready To Run

• ILと実際に実行されるコードに注意が必要
• ILをデコイにして、実際の動作をネイティブコードに隠す手法などが

ある -> R2R stomping

• https://www.virusbulletin.com/uploads/pdf/conference/vb2023/pa
pers/R2R-stomping-are-you-ready-to-run.pdf

https://www.virusbulletin.com/uploads/pdf/conference/vb2023/papers/R2R-stomping-are-you-ready-to-run.pdf
https://www.virusbulletin.com/uploads/pdf/conference/vb2023/papers/R2R-stomping-are-you-ready-to-run.pdf
https://www.virusbulletin.com/uploads/pdf/conference/vb2023/papers/R2R-stomping-are-you-ready-to-run.pdf
https://www.virusbulletin.com/uploads/pdf/conference/vb2023/papers/R2R-stomping-are-you-ready-to-run.pdf
https://www.virusbulletin.com/uploads/pdf/conference/vb2023/papers/R2R-stomping-are-you-ready-to-run.pdf
https://www.virusbulletin.com/uploads/pdf/conference/vb2023/papers/R2R-stomping-are-you-ready-to-run.pdf
https://www.virusbulletin.com/uploads/pdf/conference/vb2023/papers/R2R-stomping-are-you-ready-to-run.pdf
https://www.virusbulletin.com/uploads/pdf/conference/vb2023/papers/R2R-stomping-are-you-ready-to-run.pdf
https://www.virusbulletin.com/uploads/pdf/conference/vb2023/papers/R2R-stomping-are-you-ready-to-run.pdf
https://www.virusbulletin.com/uploads/pdf/conference/vb2023/papers/R2R-stomping-are-you-ready-to-run.pdf
https://www.virusbulletin.com/uploads/pdf/conference/vb2023/papers/R2R-stomping-are-you-ready-to-run.pdf
https://www.virusbulletin.com/uploads/pdf/conference/vb2023/papers/R2R-stomping-are-you-ready-to-run.pdf
https://www.virusbulletin.com/uploads/pdf/conference/vb2023/papers/R2R-stomping-are-you-ready-to-run.pdf
https://www.virusbulletin.com/uploads/pdf/conference/vb2023/papers/R2R-stomping-are-you-ready-to-run.pdf
https://www.virusbulletin.com/uploads/pdf/conference/vb2023/papers/R2R-stomping-are-you-ready-to-run.pdf
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R2RDumpでネイティブコードの位置を調査できる
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• Native AOT (Ahead-Of-Time)
• 自己完結型のネイティブコードに事前コンパイルする方式

• Native AOTのプログラムは起動時間が短く、メモリ使用量も少ない

• .NET runtimeがインストールされていない環境でもプログラムを実行可能
(JITコンパイラを使用しない。)

• .NET 7から実装され、比較的新しい

https://learn.microsoft.com/en-us/dotnet/core/deploying/native-aot/?tabs=windows%2Cnet8
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• Native AOT
• コンパイルしたプログラムには、いくつか特徴的な文字列が含まれる

(バージョンによる差異あり)

• hydrate/.managedセクション

• DotNetRuntimeDebugHeader(Export関数)
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• Native AOT
• 直接ネイティブコードにコンパイルするため、dnspy等のILを対象とす

るツールでは解析が困難

• C++で作成したバイナリのように見える
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３つのコンパイル手法のイメージ図
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解析のアプローチ

• シグネチャでトリアージ
• Native AOTのコードをディスアセンブルすると、静的にリンクされた

標準ライブラリ等のコードも大量に含まれる

• 本当に解析したいコードが埋もれてしまうため、標準ライブラリとそ
うでないコードを分離するためのシグネチャをあらかじめ用意する

• GhidraやIDA Proでシグネチャを適用することで、読むべきコード、そ
うでないコードを分離して可読性を向上させる
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Ghidraで解析

• Ghidra: Function ID
• https://github.com/NationalSecurityAgency/ghidra/tree/master/Ghidra/

Features/FunctionID/src/main/doc

• プログラムの関数を識別し、既知のライブラリと照合するアナライザー

• 各関数の本体をハッシュ化し、そのハッシュをインデックス化されたデー
タベースのキーとして使用、一致する関数を検索する

• 特徴
• 静的リンクライブラリの識別(ライブラリ関数の認識)

• 再配置耐性

• プロセッサー固有(異なるアーキテクチャーごとにデータベースが必要)

• 識別したライブラリ情報を自動コメント

https://github.com/NationalSecurityAgency/ghidra/tree/master/Ghidra/Features/FunctionID/src/main/doc
https://github.com/NationalSecurityAgency/ghidra/tree/master/Ghidra/Features/FunctionID/src/main/doc
https://github.com/NationalSecurityAgency/ghidra/tree/master/Ghidra/Features/FunctionID/src/main/doc
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Ghidraで解析

• Ghidra: Function ID Plug-in
• ユーザーが独自のFunctionIDデータベース(.fidb)を作成・管理できる

• 主な機能
• Choose active FidDbs

• Create new empty FidDb   

• Attach existing FidDb

• Detach attached FidDb

• Populate FidDb from programs
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Ghidraで解析

• Ghidra: Function ID Plug-in

• あるライブラリが複数のバイナリに含まれることが多く、識別を
自動化したい場合

1. ライブラリを含むソースコードをコンパイル

2. Ghidraでインポート・Auto Analyze(PDB込み)

3. Function IDプラグインでFidDb(.fidb)を作成

4. Populate FidDb from programsで関数をデータベースに入力

5. FidDb完成（以後の解析のAnalyzerで活用）
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Ghidraで解析
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Ghidraで解析

Function ID Analyzerなし Function ID Analyzerあり
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IDA Proで解析

• IDA Pro: FLIRT(Fast Library Identification and Recognition 
Technology)
• https://docs.hex-rays.com/user-guide/signatures/flirt

• IDAに標準ライブラリを認識させ、可読性を向上させることができる機能

• 特徴
• 静的リンクされたライブラリの識別

• 再配置への耐性（リンクやロード時に決定される可変バイトの無視）

• メタデータ付与（関数名とコメントの自動割り当て）

• プラットフォーム非依存とコンパイラ別管理 

• 偽陰性よりも偽陽性が小さくなるようなパターンマッチングの設計

https://docs.hex-rays.com/user-guide/signatures/flirt
https://docs.hex-rays.com/user-guide/signatures/flirt
https://docs.hex-rays.com/user-guide/signatures/flirt
https://docs.hex-rays.com/user-guide/signatures/flirt
https://docs.hex-rays.com/user-guide/signatures/flirt
https://docs.hex-rays.com/user-guide/signatures/flirt


Copyright © 2026 N.F.Laboratories Inc. 30TLP:CLEAR

TLP:CLEAR

IDA Proで解析

FLIRT シグネチャファイル適用前 FLIRT シグネチャファイル適用後
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ハンズオン
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ハンズオン(流れ)

AOTバイナリ解析のためのシグネチャの生成と適用

1. Native AOTアプリケーション発行用の環境準備とシグネチャ
生成のためのAOTバイナリを生成

2. Ghidraを使ってAOTバイナリからFidDbを生成する

3. 生成したFidDbをAOTバイナリに適用してみる

4. マルウェア検体にシグネチャを適用する
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ハンズオン #1

.NET Native AOTを使ったアプリケーションの生成に必要な環境
• Visual Studio 2022 / 2026

• C++ によるデスクトップ開発 ワークロードが必須

• Visual Studio 2026使う場合で.NET10以外の.NET8や9のアプリケーションを
Publishするためには以下の修正が必要 (2025/12/16時点)
• https://developercommunity.visualstudio.com/t/AOT-Publish-Issue-while-target-

NET-9-an/11000135?sort=newest

• .NET SDK 9.0 / 10.0

https://developercommunity.visualstudio.com/t/AOT-Publish-Issue-while-target-NET-9-an/11000135?sort=newest
https://developercommunity.visualstudio.com/t/AOT-Publish-Issue-while-target-NET-9-an/11000135?sort=newest
https://developercommunity.visualstudio.com/t/AOT-Publish-Issue-while-target-NET-9-an/11000135?sort=newest
https://developercommunity.visualstudio.com/t/AOT-Publish-Issue-while-target-NET-9-an/11000135?sort=newest
https://developercommunity.visualstudio.com/t/AOT-Publish-Issue-while-target-NET-9-an/11000135?sort=newest
https://developercommunity.visualstudio.com/t/AOT-Publish-Issue-while-target-NET-9-an/11000135?sort=newest
https://developercommunity.visualstudio.com/t/AOT-Publish-Issue-while-target-NET-9-an/11000135?sort=newest
https://developercommunity.visualstudio.com/t/AOT-Publish-Issue-while-target-NET-9-an/11000135?sort=newest
https://developercommunity.visualstudio.com/t/AOT-Publish-Issue-while-target-NET-9-an/11000135?sort=newest
https://developercommunity.visualstudio.com/t/AOT-Publish-Issue-while-target-NET-9-an/11000135?sort=newest
https://developercommunity.visualstudio.com/t/AOT-Publish-Issue-while-target-NET-9-an/11000135?sort=newest
https://developercommunity.visualstudio.com/t/AOT-Publish-Issue-while-target-NET-9-an/11000135?sort=newest
https://developercommunity.visualstudio.com/t/AOT-Publish-Issue-while-target-NET-9-an/11000135?sort=newest
https://developercommunity.visualstudio.com/t/AOT-Publish-Issue-while-target-NET-9-an/11000135?sort=newest
https://developercommunity.visualstudio.com/t/AOT-Publish-Issue-while-target-NET-9-an/11000135?sort=newest
https://developercommunity.visualstudio.com/t/AOT-Publish-Issue-while-target-NET-9-an/11000135?sort=newest
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ハンズオン #1

1. プロジェクト(AOT_TestApp)を生成

2. プロジェクトファイル(AOT_TestApp.csproj)を編集する
<Project Sdk="Microsoft.NET.Sdk">

<PropertyGroup>
<OutputType>Exe</OutputType>          <!-- 実行形式をexeで指定-->
<TargetFramework>net8.0</TargetFramework>     <!-- AOTバイナリに組み込む.NETライブラリのバージョンを指定-->
<ImplicitUsings>enable</ImplicitUsings>       <!-- using の自動追加-->
<PublishAot>True</PublishAot>           <!-- AOT発行の設定を有効化-->
<DebugType>portable</DebugType>     <!-- PDB形式の指定 (後ほど使うのでportable指定してください-->
<Optimize>True</Optimize>    <!-- 最適化を有効化(後の演習の結果が変わってくるのでTrueを指定してください)-->

</PropertyGroup>
</Project>

> dotnet new console --aot -o AOT_TestApp

※以降のワークショップで実施する手順を意識した内容になっています
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ハンズオン #1

3. Program.csに以下のリンク先のコードをコピーする

シグネチャ生成用のソースコード：
https://harfanglab.io/medias/2024/01/Program.txt

(https://harfanglab.io/insidethelab/reverse-engineering-ida-pro-aot-net/)

4. AOTバイナリの生成

exeとpdbファイルが bin¥Release¥net8.0¥win-x64¥publish 以下に生成される

> cd AOT_TestApp
> dotnet publish -r win-x64

-r <RID> : Runtime Identifier の指定 (win-x64, win-x86…)
どのプラットフォーム向けのネイティブバイナリを生成するかを指定

※dotnet publish中にバイナリに取り込むランタイムを追加でダウンロードする場合がある

https://harfanglab.io/medias/2024/01/Program.txt
https://harfanglab.io/insidethelab/reverse-engineering-ida-pro-aot-net/
https://harfanglab.io/insidethelab/reverse-engineering-ida-pro-aot-net/
https://harfanglab.io/insidethelab/reverse-engineering-ida-pro-aot-net/
https://harfanglab.io/insidethelab/reverse-engineering-ida-pro-aot-net/
https://harfanglab.io/insidethelab/reverse-engineering-ida-pro-aot-net/
https://harfanglab.io/insidethelab/reverse-engineering-ida-pro-aot-net/
https://harfanglab.io/insidethelab/reverse-engineering-ida-pro-aot-net/
https://harfanglab.io/insidethelab/reverse-engineering-ida-pro-aot-net/
https://harfanglab.io/insidethelab/reverse-engineering-ida-pro-aot-net/
https://harfanglab.io/insidethelab/reverse-engineering-ida-pro-aot-net/
https://harfanglab.io/insidethelab/reverse-engineering-ida-pro-aot-net/
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ハンズオン #2

Ghidraを使ってAOTバイナリをみてみる

• Create Project
• ghidra_11.3.1_PUBLIC¥ghidraRun.batを実行してGhidraを起動

• File → New Project からプロジェクトを作成
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ハンズオン #2

• 解析対象のファイルをインポートし、PDBを使わずに解析
• File→ Import File

• インポートしたファイルをダブルクリックしてCodeBrowserを立上げ

• 初回選択時にはAuto analyzeを実行するか問われるので Yesを選択

• PDB Universalのチェックを外して解析する
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ハンズオン #2

何もわからない
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ハンズオン #2

PDBを適用して解析

• Analysis → One Shot → PDB Universal
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ハンズオン #2

ありがたい
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ハンズオン #2

PDBが適用されている状態で、FidDbを生成していく
1. Ghidraの設定変更

File->Configure->Developerのconfigure->FidDebugPluginにチェックをいれる

2. Ghidraを再起動する
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ハンズオン #2

3. 空のFidDbの新規作成
Tools→Function ID→Create new empty FidDbを選択するとファイル作成画面に移る
ここでは、AOT_TestApp.exeのあるフォルダにdotnet8_AOT_TestApp.fidbで作成する

作成すると自動的にActiveなFid Databasesとして設定される
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ハンズオン #2

4. Function IDの生成
Tools→Function ID→Populate FidDb from programsを選択
表示されるダイアログでFidDbの情報を入力してOKを押下

※LanguageではGhidraの言語識別子を選択する
(今回はVisual Studioで検索するとわかりやすい)
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ハンズオン #3

生成したFidDbを使って先ほどのPDBなしの状態に適用してみる
1. 生成したFidDbがActiveなFid Databasesとして選択されているか確認

2. Analysisを実行
Analysis→One Shot→Function IDを選択
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ハンズオン #3

3. Before/Afterの確認

ありがたい
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ハンズオン #3 補足

IDA Pro でシグネチャ生成する流れ
1. Signatureファイル生成に必要なツール(sigmake)の準備

2. patternファイル(.pat)を生成

3. patternファイルからsignatureファイル(.sig)を生成

4. signatureファイルの適用

5. Before/After

※IDA Pro ver.8.3を使用
IDA Pro ver.8.4以上は以下を参照
https://hex-rays.com/blog/an-overview-of-the-makesig-plugin

https://hex-rays.com/blog/an-overview-of-the-makesig-plugin
https://hex-rays.com/blog/an-overview-of-the-makesig-plugin
https://hex-rays.com/blog/an-overview-of-the-makesig-plugin
https://hex-rays.com/blog/an-overview-of-the-makesig-plugin
https://hex-rays.com/blog/an-overview-of-the-makesig-plugin
https://hex-rays.com/blog/an-overview-of-the-makesig-plugin
https://hex-rays.com/blog/an-overview-of-the-makesig-plugin
https://hex-rays.com/blog/an-overview-of-the-makesig-plugin
https://hex-rays.com/blog/an-overview-of-the-makesig-plugin
https://hex-rays.com/blog/an-overview-of-the-makesig-plugin
https://hex-rays.com/blog/an-overview-of-the-makesig-plugin
https://hex-rays.com/blog/an-overview-of-the-makesig-plugin
https://hex-rays.com/blog/an-overview-of-the-makesig-plugin
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ハンズオン #3 補足

1. Signatureファイル生成に必要なツール(sigmake)の準備
Hex-Rays社のDownload centerからsigmakeというツールをダウンロードする
※My hex-raysへのログインが必要
※flairと名前の付くファイルの中に含まれる

2. patternファイル(.pat)を生成

IDA Pro 8.0以降であればpatternファイル生成用のプラグ
インが標準搭載されている。PDBを読み込んだ状態で以下
のプラグインを使いpatternファイルを生成する
Edit→Plugins→Create PAT from the database
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ハンズオン #3 補足

3. patternファイルからsignatureファイル(.sig)を生成

以下のようなメッセージが表示された場合には手動でCollisionsを解決する必要がある

同フォルダにある.excファイルを、以下の通り編集する

> sigmake.exe AOT_TestApp.pat dotnet8_AOT_TestApp.sig

• 衝突しているパターンで優先するシンボルの先頭に+を追記しておく
• 衝突しているパターンを除外する場合は何もしない
• ファイル先頭にある;から始まる行を削除しておくとこのファイルを読み取り処理する
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ハンズオン #3 補足

4. signatureファイルの適用

• 生成された.sigファイルをIDAのインストールディレクトリ下にあるsigフォルダ
の中の適当なフォルダに入れておく(アーキテクチャごとにフォルダが存在するの
で、ここではpcフォルダに入れる)

• File→Load file→FLIRT signature file...を選択し、先ほど格納したsigファイルを
選択するとsignatureが適用される
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ハンズオン #3 補足

5. Before/After

ありがたい
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マルウェア検体への適用

シグネチャを活かすためには、検体とシグネチャ生成のために利用したバイナリの
TargetFrameworkのバージョン(.NETのバージョン)が一致している必要がある

<Project Sdk="Microsoft.NET.Sdk">
<PropertyGroup>
<OutputType>Exe</OutputType>          <!-- 実行形式をexeで指定-->
<TargetFramework>net8.0</TargetFramework>     <!-- AOTバイナリに組み込む.NETライブラリのバージョンを指定-->
<ImplicitUsings>enable</ImplicitUsings>       <!-- using の自動追加-->
<PublishAot>True</PublishAot>           <!-- AOT発行の設定を有効化-->
<DebugType>portable</DebugType>     <!-- PDB形式の指定 (後ほど使うのでportable指定してください-->
<Optimize>True</Optimize>    <!-- 最適化を有効化(後の演習の結果が変わってくるのでTrueを指定してください)-->

</PropertyGroup>
</Project>

プロジェクトファイルの内容
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マルウェア検体への適用

今まで使ってきているバイナリ(AOT_TestApp.exe)に対して、複数の.NET
バージョンで生成したシグネチャを適用してみる

.NET8.0
(正解 )

.NET9.0 .NET10.0
(リネームできるシンボル数が少ない )
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マルウェア検体への適用

Native AOTバイナリかどうかの推測

• .NET8.0の場合：
• hydratedや.managedという名前のセクションが存在している

• DotNetRuntimeDebugHeaderという名前のExportが存在している

• .NET9.0や10.0の場合：
• DotNetRuntimeDebugHeaderという名前のExportが存在している
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マルウェア検体への適用

組み込まれている.NETバージョンの推測
• stringsを確認する

• Ghidraでruntime_version文字列を参照しているサブルーチンの周辺を調査する
と、.NETバージョンがみえるサブルーチンが存在する
(PDBを適用してみるとこれはRhGetRuntimeVersionと名前のつくサブルーチン)
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ハンズオン #4

マルウェア検体にシグネチャを適用してみよう

使用するサンプルはこちら

• 検体A: f5b31bd394e0a3adb6bd175207b8c3ccc51850c8f2cee1149a8421736168e13e

• 検体B: 9726e5c7f9800b36b671b064e89784fb10465210198fbbb75816224e85bd1306

• 検体C: 2c5d40e2bc5d03c9bbf314b6a18133bbd3ea655e0586deb61bc668d91f7959e5

ZIP PW: jsac2026
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ハンズオン #4

検体Aにシグネチャを適用してみよう

• .NETバージョンの特定 →  .NET8.0.10

Native AOTバイナリの可能性あり .NETのバージョン情報を発見

8.0.10
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ハンズオン #4

検体Aにシグネチャを適用してみよう

• シグネチャの適用

ありがたい
しかし、まだまだつかみどころがない…
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ハンズオン #4

早く終わった人は検体B, Cにもシグネチャを適用してみてください

検体C



Copyright © 2026 N.F.Laboratories Inc. 59TLP:CLEAR

TLP:CLEAR

前半まとめ

• Native AOTでコンパイルされたバイナリとそれ以外の方法でコ
ンパイルされたバイナリの解析方法は大きく異なる

• バイナリには大量の標準ライブラリが含まれるため、シグネ
チャを使ったユーザー定義のコードとの分離が有効

• シグネチャを作成して解析対象のバイナリに適用した
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~Break Time~
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Re:birth the fidb: 

Reverse Engineering the .NET AOT Malware

section #2



Copyright © 2026 N.F.Laboratories Inc. 62TLP:CLEAR

TLP:CLEAR

はじめに

• シグネチャの適用により標準ライブラリとユーザーコードを分
離には成功した

• しかし、文字列リテラルへの参照が失われてしまっているため
コードの可読性が低い

• デバッグ実行によって文字列リテラルへの参照を復元すること
は可能だが、解析効率が悪い(手間がかかる)
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はじめに

• 以下のように、String型のオブジェクトへのポインタが
unk_XXXとなっていて、”Hello, World!”などの文字列が直接的
には判別できない
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はじめに

• unk_XXXの参照先は実行時に初期化される領域
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はじめに

• デバッグ実行で解析を進めると、参照先の具体的な文字列を特
定(ただし参照先を都度確認する手間がかかる)
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はじめに

• 本セクションでは、Native AOTのコンパイル時の特徴的な動作
(データのhydrateなど)の概要を学び、静的解析の可読性を向上さ
せる手法を習得する
• オブジェクトのメタデータ等を静的に復元し、シンボルを自動リネームす

るGhidraプラグインの活用方法を実践する

• ※ Native AOTの動作解説は.NET 8をベースとしている
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プラグイン適用による解析結果の比較
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プラグイン適用による解析結果の比較

ハンズオンの前に、
Native AOTバイナリの実行時の挙動をさらに深堀します

(プラグインの動作理解に役立ちます)
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Native AOT

Native AOTでプログラムをコンパイルすると、、

• オブジェクトの型に関するメタデータや、オブジェクト(Frozen Object)を圧
縮した形でバイナリ内に格納する(Dehydrate)

• プログラム実行時に、バイナリ内の圧縮データを展開することで、メタデー
タやオブジェクトへの参照を復元する(Rehydrate)

メタデータ     : 型情報やVTable等を管理するMethod Table

Frozen Object: コンパイル時に生成される静的なオブジェクト(メタデータと同じく、圧縮した
状態でバイナリに配置される)
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Native AOT

DehydratedData

実行時におけるデータの展開(Rehydrate)プロセスのイメージ

Copy
Zero Fill
PtrReloc
・・・

managed code

Method Tables
参照

参照展開

データ展開

Frozen Objects

DehydratedData

managed code

Method Tables

Frozen Objects

プログラム実行前 プログラム実行中
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Native AOTバイナリ内にはReadyToRunヘッダーが含まれる

実行時にはランタイムのコードがこのセクションを起点にメタデータを展開

ReadyToRun

Signature(“RTR”)

Major Version

Minor Version

Flags

NumberOfSections

EntrySize

EntryType

(各セクション)

・・・

ReadyToRun Header(イメージ)

ReadyToRun Header

プログラム

DehydrateData

FrozenObjectRegion

・
・
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ReadyToRunヘッダー配下の各エントリのうちの１つがDehydratedDataを指
し、圧縮されたデータを参照

ReadyToRun

SectionType

Flag

Start pointer

End pointer

Signature(“RTR”)

Major Version

Minor Version

Flags

NumberOfSections

EntrySize

EntryType

(各セクションが続く)

DehydratedData

・・・

DehydratedDataのデータ構造例*

* 各メンバは実際の名称ではない
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ReadyToRun Headerの後続のDehydrateDataから、圧縮されたデータを参照
して別のセクションに展開する

ReadyToRun

SectionType

Flag

Start pointer

End pointer

Signature(“RTR”)

Major Version

Minor Version

Flags

NunberOfSections

EntrySize

EntryType

(各セクション)

DehydrateData

・・・

https://github.com/dotnet/runtime/blob/main/src/coreclr/tools/Commo
n/Internal/Runtime/ModuleHeaders.cs

ランタイムソースコード
におけるセクションの定
義

https://github.com/dotnet/runtime/blob/main/src/coreclr/tools/Common/Internal/Runtime/ModuleHeaders.cs
https://github.com/dotnet/runtime/blob/main/src/coreclr/tools/Common/Internal/Runtime/ModuleHeaders.cs
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Dehydrate/Rehydrate

DehydratedDataセクションのStart pointer(offset0x08)が指す先に圧縮された
データの展開用コードが格納されている

RVA

Command+payload

Command+payload

Command+payload

・・・

SectionType(207(0xCF))

Flag

Start pointer

End pointer

可変長

イメージ図
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Dehydrate/Rehydrate

• 展開コードはcommandの種類とcommand データ(payload)から構成され
る

• payloadの大きさによって可変長のデータ構造

命令 値 説明

Copy 0x00 データのコピー

Zero Fill 0x01 0で初期化

RelPtr32Reloc 0x02 再配置(REL_BASED_RELPTR32) payloadがRVA

PtrReloc 0x03 再配置(REL_BASED_HIGHLOW/REL_BASED_DIR64) 絶対アドレス

InlineRelPtr32R
eloc

0x04 再配置(REL_BASED_RELPTR32)、payloadがRVA

InlinePtrReloc 0x05 再配置(REL_BASED_HIGHLOW/REL_BASED_DIR64)、絶対アドレス

https://github.com/dotnet/runtime/blob/main/src/coreclr/tools/Common/Internal/Runtime/DehydratedData.cs

https://github.com/dotnet/runtime/blob/main/src/coreclr/tools/Common/Internal/Runtime/DehydratedData.cs
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Dehydrate/Rehydrate

エンコードロジックの実装例(DehydratedData.csより抜粋)

https://github.com/dotnet/runtime/blob/main/src/coreclr/tools/Common/Internal/Runtime/DehydratedData.cs

データ長に応じた可変長エンコード

https://github.com/dotnet/runtime/blob/main/src/coreclr/tools/Common/Internal/Runtime/DehydratedData.cs
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Dehydrate/Rehydrate

• デバッガによるランタイムのデータ展開処理のトレース

• RehydrateDataがメタデータを展開する中核となるルーチン
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Dehydrate/Rehydrate

• Dehydrated Dataの先頭1byteから命令の種類を識別するロジック

commandの抽出
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Dehydrate/Rehydrate

• 命令コード(command)に基づく、処理の分岐(Switch-Case)

command(0x0~0x5)のチェック
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Dehydrate/Rehydrate

• 例(Copyの場合)

48 E0 FF FF FF FF FF FF FF 08

DehydratedDataの先頭1byteを取り出す

48

下位3bitを命令コードとして抽出、
0x48 and 0x07 → 0x00
上位5bitを取り出して、
0x48 sar 0x03 → 0x09

Case0(0x00) == Copy
0x9      == 9bytes分
すなわち、2bytes目以降の9バイト分を
hydrateセクション領域に展開する、という
処理になる



Copyright © 2026 N.F.Laboratories Inc. 81TLP:CLEAR

TLP:CLEAR

Dehydrate/Rehydrate

• 例(Copyの場合)
• Dehydratred Data(.rdata等)からhydrateセクションへのデータ展開
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Dehydrate/Rehydrate

• 例(Zero Fillの場合)

21 20 5F FA 9F FA 02 0C DA

DehydratedDataの先頭1byteを取り出す。

21

下位3bitを命令とすると、
0x21 and 0x7 → 0x01
上位5bitを取り出して、
0x21 sar 3 → 0x04

Case1(0x01) == Zero Fill
0x4      == 4bytes分
すなわち、hydrateセクションを4バイト分、
ゼロで埋める、という処理になる。

（1バイトの命令から、4byte分のデータ
を展開したことになる。）
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Dehydrate/Rehydrate

• 例(Zero Fillの場合)
• hydrateセクションの所定の位置から4バイト分を0で埋める(見かけ上

は変わらず)
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Dehydrate/Rehydrate

• 最終的に、hydrateセクションにはMethod TableやFrozen Objectなどが配置
される

• Method Tableには型の種類やサイズ、Method TableへのポインタやVtable
等の情報が含まれている

_uFlags

_uBaseSize

_relatedType

_usNumVtableSlots

_usNumInterfaces

_uHashCode

VtableSlots

Interface

・・・

Method Tableの
メモリ上の構造イメージ

_uFlagsは型の種類を表すビットフィールド

_relatedTypeに親クラスのMTへのポインタ

VtableSlotsには_usNumVtableSlotsの数だけの
仮想メソッド
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Dehydrate/Rehydrate

MT

MT

hydrateセクションのメモリ上のイメージ

_relatedType

・・・

_uFlags(0x50000000)

_relatedType(=0)

_usNumVtableSlots(=3)

_usNumInterfaces(=0)

・・・

System.ObjectのMethod Table

Method Table

relatedTypeから親のMTが分かる
relatedTypeを辿ることで最終的に
System.ObjectのMTに到達し、MTの継承
関係の全体像を把握できるhydrateセクション上には復元された複数のMethod Tableが

連続して配置される
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Dehydrate/Rehydrate

MT

MT

Frozen Object

hydrateセクションのメモリ上のイメージ

Method Table

Length

“H”

“e”

“l”

“l”

“o”

_relatedType

・・・

System.StringのMethod Table

文字列オブジェクトのイメージ

Frozen Object

Rehydrateにより、文字列のFrozen Object
もhydrateセクションに展開される
展開された文字列オブジェクトは対応する
文字列型(System.String)のMTを保持Frozen Objectも同様に復元されて

hydrateセクション内へと配置される
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Dehydrate/Rehydrate

MT

MT

Frozen Object

hydrateセクションの構造イメージ

Method Table

Length

“H”

“e”

“l”

“l”

“o”

NULL

_relatedType

・・・

System.stringのMethod Table

Object

Frozen Object

hydrateセクション内のFrozen Objectの領域に文字列型
のオブジェクトレイアウトが並ぶ
Frozen Objectの領域は、ReadyToRunディレクトリの
0x206のセクションの箇所のポインタで示されている
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Ghidraプラグイン

静的解析において、ディスアセンブル画面では文字列リテラルへのポイン
タが初期化されていないため、文字列情報が表示されていない。これを以
下の優れたプラグイン(Ghidra)を使うことで、動的解析(デバッグ実行)をせ
ずに圧縮されたコードを静的に展開することができる。

• Ghidra .NET Native AOT Analyzer Plugin

• https://github.com/Washi1337/ghidra-nativeaot

• https://blog.washi.dev/posts/recovering-nativeaot-metadata/

https://github.com/Washi1337/ghidra-nativeaot
https://github.com/Washi1337/ghidra-nativeaot
https://github.com/Washi1337/ghidra-nativeaot
https://github.com/Washi1337/ghidra-nativeaot
https://blog.washi.dev/posts/recovering-nativeaot-metadata/
https://blog.washi.dev/posts/recovering-nativeaot-metadata/
https://blog.washi.dev/posts/recovering-nativeaot-metadata/
https://blog.washi.dev/posts/recovering-nativeaot-metadata/
https://blog.washi.dev/posts/recovering-nativeaot-metadata/
https://blog.washi.dev/posts/recovering-nativeaot-metadata/
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Ghidraプラグイン

• 圧縮データをhydrateセクションに展開し、ディスアセンブル/デコンパイ
ル画面の変数をアノテートしてくれるプラグイン

• Method Tableを探し出してウィンドウに列挙してくれる
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ハンズオン
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ハンズオン #5

プラグインのインストール
• ghidra_11.3.1_PUBLIC¥Extensions¥Ghidra¥ 以下に、追加するプラグイ

ンzipファイルを配置する

• File → Install Extentionsから追加するプラグインを選択する

• 再起動する
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ハンズオン #5

プラグインのインストール
• ghidra_11.3.1_PUBLIC¥Extensions¥Ghidra¥ 以下に追加するプラグイ

ンzipファイルを配置する

• File → Install Extentionsから追加するプラグインを選択する

• 再起動する
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ハンズオン #5

メタデータ、Frozen Objectの復元
• Search→Memoryで“RTR”を検索(ReadyToRun ヘッダーを探す)

• 見つかったらコンテキストメニューから、Add labelを選択して、
"__ReadyToRunHeader"のラベルを設定する
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ハンズオン #5

メタデータ、FrozenObjectの復元
• Search→Memoryで“RTR”を検索(ReadyToRun ヘッダーを探す)

• 見つかったらコンテキストメニューから、Add labelを選択して、
"__ReadyToRunHeader"のラベルを設定する

• Analysis→One Shot→Native AOT Analyzerを選択

右クリック -> Add label
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ハンズオン #5

メタデータ、Frozen Objectの復元
• Analysis→One Shot→Native AOT Analyzerを選択
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ハンズオン #5

メタデータ、FrozenObjectの復元
• Analysis→One Shot→Native AOT Analyzerを選択

ありがたい
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ハンズオン #5

早く終わった方は他の検体にも適用、実際に解析してみて変化を
味わってみてください
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まとめ

• Native AOTバイナリに対し、GhidraやIDA Proでシグネチャを作
成・適用した

• Method Tableなどメタデータの展開(Rehydrate)処理の流れを解
説した

• Ghidraプラグインでメタデータを静的に復元し、文字列を識別で
いるようにした

• Native AOTマルウェアに遭遇した際には、本手法をぜひ活用して
みてください
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Thank you !
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参考

• Native AOT
• https://learn.microsoft.com/en-us/dotnet/core/deploying/native-

aot/?tabs=windows%2Cnet8

• GitHub - dotnet/runtime: .NET is a cross-platform runtime for cloud, mobile, desktop, 
and IoT apps.

• Malware
• IBM X-Force Threat Analysis: QuirkyLoader - A new malware loader delivering 

infostealers and RATs | IBM

• Booking.com Phishing Campaign Targeting Hotels and Customers - Sekoia.io Blog

• Impersonated GenAI Site Lures Victims to Infostealer Download - Check Point 
Research

• プラグイン
• https://github.com/Washi1337/ghidra-nativeaot

• https://blog.washi.dev/posts/recovering-nativeaot-metadata/
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